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ABSTRACT. In this note, a short report is presented concerning a symbolic approach
to tiling theory which has been developed in Bielefeld over the last 15 years.

0. INTRODUCTION

Spatial structures displaying — one way or the other — some kind of repetitive
regularity have attracted the attention of the human mind from prehistoric times
on. Yet, it took more than two thousand years after the first complete classification
and enumeration results had been obtained by the Pythagorean school before mathe-
maticians conceived of and explicitly used the group concept as an elegant conceptual
framework for formalizing the arguments on which such classification results had been
based.

Since then, phenomenal progress has been achieved. Still, for a long time, group-
theoretical concepts appeared to detect phenomena related to the algebraic properties
of symmetry operations (that is, the various ways they combine to make up a group)
only, and to be unable to represent the individual geometric-topological manifesta-
tions of symmetry-related regularity as well — a point in case being the multitude
of very differently structured tilings all exhibiting the same kind of symmetry.

In this note, we will present a short outline of a theory which — based on ele-
mentary group-theoretical concepts — provides means to symbolically represent all
sorts of regular tilings and, hence, to deal with tiling theory on the basis of symbolic
calculation procedures.

In Section 1, we will present some formal definitions, including the simple group-
theoretic context on which they are based. In Section 2, the symbolism developed
in the first section will be correlated with tiling theory. In Section 3, a survey of
various results obtained with our method will be presented and, finally, an appendix
introduces the untiring reader to the computer program RepTiles.

1. DELANEY SYMBOLS

For a given finite set I of cardinality n+1 > 1,let ¥ =%;:=(o0;|i€ ;07 =1)
denote the group which is freely generated by a family (o;);c; of n + 1 involutions.
We consider pairs (D, M) consisting of a (right) transitive ¥-set D and a map

M:D — (N)rxr: D (mi;(D))ijer
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from D into the set of integral [ x [ matrices such that
D(oio;)™s(P) = D,
mij(D) = mji(D) = my;(Doi),

and
for all D € D and ¢,j € I. Any such pair will be called a Delaney symbol (relative to
the index set [ or, for short, “over I”).

Obviously, any transitive ¥-set D can also be described as a set together with a
family of n 4+ 1 permutations

7.:DSD (iel)

of order at most 2 such that the subgroup (@; | ¢ € I') of the full permutation group
acts transitively on D. Equivalently, it can also be described as a set D together with
a subset £ C D x D x [ such that E coincides with its transpose

Et = { (D17D2,l) | (D27D17L) S E}

and such that, for every D € D and ¢ € [, there is precisely one D' € D with
(D, D';1) € E, while the induced graph

D
(D, { {D,D'} € (2) ‘ there exists some 1 € [ with (D, D';i) € E })

is connected.

For any two such pairs (Dy, M) and (D, My), let Hom( (Dy, M), (Ds, Mz) )
denote the set of maps ¢: Dy — Dy such that M;(D) = My(p(D)) and ¢(Do;) =
©(D)o; for all D € Dy and ¢ € I. Note that this way we get a category Del; whose
objects are the Delaney symbols (over /) and whose morphisms are the Hom-sets we
have just defined. Note also that any morphism is necessarily an epimorphism, and
that it is an isomorphism if and only if it is bijective or — equivalently — if and only
if it is injective; hence, if #D; = #D, < oo, then any morphism from Dy into D, is
an isomorphism.

2. SYMBOLS AND TILINGS

The basic observation on which all further developments are based is the following
one (cf. [Del80], [Dre80], [Dre84] and [Dre87]): given
e a connected n-manifold X without boundary,
e the i-skeleta X; C X (¢ =0,...,n) of a regular CW-structure 7' on X, and
e a discrete group I' of automorphisms of X respecting this CW-structure (that
is, satisfying vX; = X; for all: =0,...,n and v € I),
one can associate with these data a Delaney symbol (D, M) = (D(x 7,r), M(x,1,r))
over [ :={0,...,n} as follows:
First put X_; := 0; then consider

3":={F=(Fo,---,Fn)GHWo(Xi—qu) Fioi CF; fori:l,...,n},

1=0
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the set of (maximal) flags of X, and observe that
(a) for each flag F' = (Fo,..., F,) and each ¢ € {0,...,n}, there exists precisely
one flag F' = (Fy, ..., F}) with F; # F{ and F; = F} for all j # 1, so there is a
well-defined natural Y-action on F defined by Fo; := F' whenever F, F’" and
¢ are as above;
(b) F becomes a transitive X-set this way;
(¢) my;(F) := min( m € N | F(o,0;)" = F ) always exists (that is, for every
F € F and ¢,5 € {0,...,n} there exists some m € N with F(o,0;)" = F),
and one has m;;j(F) = m;;(F) = m;;(Fo;) as well as m;(F) = 1, and, in
addition, m;;(F) =2 for |i — j| > 1, for all F € F and ¢,j € {0,...,n};
(d) the action of I' on X induces a free action of I' on F which satisfies (vF')(o;) =
v(Fo;) and mj(vF) =m;(F)forally €', F € Fand i,5 € {0,...,n}.
This implies easily that one can associate to the triple (X, 7,I') a Delaney symbol
(D, M) = (D(X,T,F)aM(X,T,F)) by
e putting D :=T'\ F, the set of orbits ['- F':= { vF |y € I' } of I' contained in
F,
and
e observing that the relations (yF')(0;) = v(Fo;) and m;;(vF) = m;;(F) imply
that there is an induced transitive (right) ¥-action on D and that

M(T - F) = (m(F))ij=0,..n
is well-defined and satisfies the relations mentioned above.

Now (cf. [Dre84] and [Dre87]), one can invoke standard facts about how to com-
pute the fundamental group of a CW-complex to conclude that given two triples
(X,7T,T') and (X', T",1") consisting of simply connected manifolds X, X’ with regular
CW-structures T, T” and discrete automorphism groups I', I, the resulting Delaney
symbols

(D, M) = (Dx11), Mx.11))
and

('D,,M/) — (‘D(X',T',F’)yM(X’,T',F'))

are isomorphic if and only if there exists a homeomorphism ®: X = X' with ®(X;) =
X!/ fori=0,...,nand I" = { ®y®~' | v € T' }, while there exists a morphism
0: (D, M) — (D', M’) if and only if there exists a homeomorphism ®: X = X’ with
O(X;)=X!/foralli=0,...,nand I" 2 { &40~ |y T }.

3. APPLICATIONS

The transformation from the geometry of tilings to the combinatorics of Delaney
symbols which can be based on this observation has turned out to be as fundamental
a starting point for the development of a rigorous mathematical (and even comput-
erizable) theory of tilings as the transformation from classical geometry to algebra
and analysis based on Descartes’ coordinate systems was for the development of a
rigorous mathematical theory of space and spatial structures in general. It also allows
to manipulate tilings on the symbolic level and, hence, to construct algorithms which
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— performing on the symbolic level — can handle all sorts of questions related to
the comparative analysis, classification, and enumeration of tilings conforming with
essentially any preassigned list of geometric specifications (cf. [DS84], [DS86], [DHI1],
[DDMP93], and more references given below). And finally, by reversing this transfor-
mation (whenever possible), one can actually generate geometric realizations as well
as visual displays of all such (classes of) tilings on the computer screen, and one can
thoroughly manipulate these visual displays by translating mouse-clicks and -motions
on the screen into corresponding actions and transformations on the symbolic level

(cf. [DH92] and Section 4).

3.1. Two-Dimensional Tilings. In particular, the symbolic approach described
above has led to an elegant and consistent classification theory for two-dimensional
tilings, which is based on the following additional observations:

First, if (D, M) is a finite Delaney symbol over [ := {0, 1,2}, then the curvature
of (D, M), defined by

. 1 1 1
DM = DXE:Q (mm(D) * mia(D) * moa(D) 1) 7

essentially decides whether (D, M) is the symbol of a tiling of the euclidean plane,
the hyperbolic plane, or the sphere. More precisely, the tiling symbolized by (D, M)
is euclidean, hyperbolic, or spherical if and only if its curvature is zero, negative, or
positive, respectively (cf. [Dre87], [DH8T]).

Second, if ' is a discrete group of automorphisms of some connected 2-manifold
X with compact orbit space X/I', then there is some number ¢t = ¢ € N such that
for any number k € N and for any tile-k-transitive tiling (X, T,T'), the size of the
corresponding Y-set D x 7y is bounded by tk. Here, a tiling (X, T,T) is called tile-k-
transitive if the number of I'-orbits in the set of tiles (i.e. cells of maximal dimension)
of T'is exactly k (cf. [Dre84], [Dre87], [DH8T]).

Third, any tiling of the euclidean or hyperbolic plane or of the sphere can be
derived systematically from some so-called fundamental tilings by applying a finite
number of simple geometric operations (cf. [Del61], [DHZ92]). Here, a fundamental
or, more precisely, I-fundamental tiling is a tile-(1—)transitive one with the additional
property that none of its symmetries (except, of course, the identity) leave any tile
invariant.

The first two of these observations led to algorithms for the classification of tile-k-
transitive tilings, where k is a small integer. For example, in the euclidean case, the
number {p is at most 12. In [DHZ92], all the tile-2-transitive tilings of the euclidean
plane were classified by means of a computer by first enumerating all the possible
symbols of size at most 24 and then extracting those having zero curvature. This
method, however, is rather inefficient, since it generates lots of symbols which do not
correspond to tilings of the desired type.

The third observation, which was translated to the symbolic level and implemented
as a computer program in [Hus93a], leads to algorithms which exclusively produce
tilings with arbitrarily prescribed symmetry groups, which makes it possible to clas-
sify all the tile-1-, 2- and 3-transitive tilings of the euclidean plane and the sphere.
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Due to the fact that there are infinitely many discrete co-compact groups of isometries
of the hyperbolic plane and therefore infinitely many equivalence classes of hyper-
bolic two-dimensional tilings, it was necessary to choose a finite collection of such
groups as the symmetry groups of the tilings to be classified, to achieve analogous
classification results for tilings of the hyperbolic plane.

A variant of the third observation also is the basis for efficient methods to construct
geometric realizations of given two-dimensional Delaney symbols. A general method
to construct realizations of symbols corresponding to fundamental tilings is described
in [Wes91] and [Bor94]. An arbitrary symbol is realized by first reducing it to a
fundamental one, then realizing the fundamental symbol, and finally reversing the
sequence of reductions on the level of geometric realizations (cf. [Wes91], [Del90]).

The combination of our symbolic approach with geometric construction methods
also has proved to be fruitful for certain more specific classification problems, like
the classification of the so-called 4-colourable tilings of the euclidean plane, i.e. those
tile-4-transitive tilings with the property that no two tiles in the same I'-orbit share
an edge (cf. [Hus94]), or of the so-called net-like partial tilings of the euclidean plane
(cf. [Hus93b]). A net-like partial tiling can be considered as one allowing a partition
of the tiles into two classes in such a way that the first class consists of one I'-orbit
while the second class consists of all the other I'-orbits, and such that no two tiles
of the second class share an edge. The interiors of the tiles in the second class may
then be considered as holes cut out of the plane, while the tiles in the first class may
be considered to be forming a tiling of the rest of the plane.

3.2. Higher-Dimensional Tilings. As mentioned before, there are a number of
alternative ways to describe the symbol corresponding to a tiling. Although the ad-
vantages of the chosen algebraic formulation are evident, most of the early computer
implementations do not make use of this algebraic background. This is probably
due to the fact that the algebraic structure of two-dimensional symbols is compar-
atively simple; so, for the necessary operations on these symbols, specialized ad-hoc
implementations have been used instead of sophisticated general algorithms from
computational group theory or related fields.

This situation changes significantly when one considers higher-dimensional tilings
and their symbols. In [Del94], practical algorithmic methods are presented which can
be used to decide whether a given Delaney symbol (D, M) over [ := {0,1,2,3} is
the symbol of a tiling of the usual euclidean 3-space. This question can be reduced,
by non-trivial means, to a purely topological one, which is related to the problem of
deciding whether two given three-dimensional triangulated manifolds are homeomor-
phic. No practical general solution for the latter problem is currently available, and,
consequently, the same holds for our original problem. There are, however, practical
criteria based on the algebraic structure of the possible symmetry groups of such
tilings, namely the so-called three-dimensional crystallographic space groups, which
can be used to significantly reduce the number of candidate symbols.

Here, by a tiling of euclidean 3-space, we mean a tiling (X,7,I'), where X is
the three-dimensional real vector space R® and I' is a discrete cocompact group of
isometries of X with respect to the usual euclidean metric. Bieberbach, in his classical
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papers [Biell] and [Biel2], showed that each such group contains a normal subgroup
of finite index which is generated by three linearly independent translations (and
thus is abstractly isomorphic to the direct sum of three copies of the infinite cyclic
group). He also showed that (in any given dimension) there is only a finite number of
such groups (up to affine equivalence). For dimension 3, these had been completely
classified by Fedorov and by Schonflies in 1890.

One can derive from these facts a neccessary algebraic condition for the euclidicity
of a three-dimensional Delaney symbol, which can be used for implementing a com-
puter program which first constructs a finite presentation of the group I' from the
data (@(X7T7p), AM(X’TI)) and then tests whether or not I' is isomorphic to one of the
crystallographic groups classified by Fedorov and Schonflies. Here, various standard
algorithms from computational group theory have to be invoked.

Since efficient implementations of the above-mentioned algorithms are far from
being straightforward, the computer algebra system GAP ([ST93]) was chosen as a
platform for the implementation of the euclidicity criterion. The GAP-system con-
tains a number of routines for finitely presented groups which are very useful for our
purposes, as well as a high-level programming language, which, among other things,
contains permutations and extensible arrays as basic data types. On this basis, it was
fairly easy to re-implement many of the standard operations on Delaney symbols, now
making explicit use of the algebraic structures involved and using a number of the
higher level group-theoretic routines available in GAP.

More advanced euclidicity criteria have also been implemented in GAP, as well as
routines for the systematic generation of symbols. We have applied these programs to
establish the fact that there are exactly 923 symbols of size up to 10 of non-degenerate
(cf. [Del94]) euclidean space tilings. These have been found by investigating a list
of about 33000 ‘locally euclidean’ candidates. As a second application, a result from
[DHM93] about face-transitive euclidean space tilings, which had been found by using
the traditional computational techniques together with a large amount of case by case
analysis done ‘by hand’, has been reproduced completely automatically.

4. ApPENDIX: COMPUTING PERIODIC STRUCTURES WITH REPTILES

(The following text is an excerpt of the user’s manual for the program RepTiles
([DH92]), which implements several of the concepts and ideas presented above.)

4.1. Welcome. Welcome to REPTILES, a Macintosh application for interactively
designing and systematically generating periodic 2-dimensional tilings and patterns.
This multi-window, easy-to-use program will let you

e study symmetry and 2-dimensional geometry, if you are a mathematician,

e enumerate possible 2-dimensional crystal-structures, if you are a crystallogra-
pher or chemist,

e design complex and interesting patterns, if you are a designer, or

e explore a whole new world of fascinating periodic structures, if you are, well,
just interested ...
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REPTILES is based on the mathematical theory of Delaney-Symbols. It uses com-
pletely new combinatorial algorithms to systematically solve one of the oldest math-
ematical questions ever posed:

Which geometric shapes fit together perfectly, i.e. without gaps or overlaps, to yield
a periodic, i.e. highly symmetric, pattern or tiling?

With REPTILES you can view, design and systematically generate periodic tilings
of the plane. You have access to, and can create your own, databases of thousands
of different periodic patterns or tilings. By selecting and dragging objects, you can
reshape your tilings. You have full control over the style, width, color and fill of all
vertices, edges and tiles in the structures.

REPTILES enables you to perform topological transformations on tilings. Using
transformations such as dualization, vertex-truncation and edge-contraction you can
easily build more and more complex tilings, starting from very simple ones. REPTILES
also allows symmetry breaking and symmetry-making, perhaps the most basic of all
transformations.

M.I. Stogrin and E. Zamorzaeva, both pupils of the famous Russian mathematician
B.N. Delone, proved the following: Starting with the 46 fundamental tilings of the
plane (in document Fundamental), by applying the operations split and glue (as
implemented in REPTILES), one can systematically produce all possible types of
periodic tilings of the plane.

Although designed to handle plane tilings, the program can also draw spherical ones, and is able

to display the fundamental regions of hyperbolic tilings.

4.2. REPTILES is Shareware. REPTILES. is shareware. If you like the program, or
intend to use it regularly, then please support it by registering as a REPTILES user.
This is done by sending your name, address, name of institution or company, and a
check (made out to Daniel Huson) covering USD 30 or DM 45, for a single-user
license to:

Daniel Huson

FSP Mathematisierung
Universitat Bielefeld
33501 Bielefeld

Germany.

These terms apply only to non-commercial use. If you intend to use the application
commercially, then please contact us for details of terms of use.

As a registered REPTILES-User, we will (try to) answer all your questions con-
cerning REPTILES. You will receive a registration code and the latest version of the
program. The registration code will be valid for all future versions of the program.
Please pass on only unregistered copies of REPTILES.

As long as people keep registering, we’ll keep working on the program ...

4.3. Installation. You will find REPTILES compressed in the form of a self-ex-
tracting archive. To install the application, insert the disk and then double click on
the REPTILES2.0.sea icon. (Or, if you have obtained the program via ftp, you must
first convert from binhex format.) A Save File dialog will appear asking you where
you want the REPTILES directory installed to. The program and its files require
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about 1700K of hard disk memory. Note that two versions of the program are copied
to your disk: REPTILES2.0 FPU and REPTILES2.0 NoFPU. Depending on whether
your Macintosh has a FPU or not, delete which ever version of the program you do
not need.

In the following sections, we will walk you step-by-step through your first REP-
TILES session.

4.4. Opening a Tiling From a Database. REPTILES supports two types of doc-
uments, Databases and Tilings.

o A Database document is a collection of raw tilings. Such files can be found in
the Databases folder. Usually you will open a Database, look for a tiling that
you like and then open it as a new Tiling document.

e A Tiling document contains precisely one tiling. Initially this tiling will be
raw, meaning that its tiles will be white and all edges will be thin lines. A
Tiling can be modified in a number of ways. Some changes only affect the
appearance of the tiling, whereas as others produce a completely new tiling,
which will then appear as a new Tiling document in a new window.

To get started, open the Databases folder and then launch REPTILES by double-
clicking on e.g. the Heaven and Hell document. Heaven and Hell is a Database docu-
ment consisting of 117 different raw tilings. (The tilings are inspired by M.C. Escher’s
Heaven and Hell.) To see the different tilings, you can scroll through the document
using the scroll bar. Once you have found a tiling that you like, press the New button
at the bottom of the Heaven and Hell window to open a new document containing a
copy of the tiling currently visible in the Heaven and Hell window.

4.5. Changing the Shape of Tiles. Now you should be looking at a document
titled Tiling:Untitled-1. To modify the shape of the tiles of the tiling, go into the
Edit menu and choose the Select All item. This will highlight all selectable parts of
the tiling. Note that, for each type of vertex, edge and tile that appear in the tiling,
exactly one is selectable.

Two vertices, edges, or tiles are called equivalent or of the same type, if they can be mapped on
to each other by a symmetry - a translation, reflection, rotation or glide-reflection - of the tiling.
Sometimes REPTILES will draw the tiling with more symmetries than are actually encoded in the
mathematical symbol of the tiling. To force REPTILES to draw the correct symmetry, select Display
Exact Symmetry in the Layout menu.

Move the mouse to one of the handles (black squares) that lies on a vertex or on an
edge-center. Press the mouse button and then, keeping it pressed, drag the vertex or
edge-center a short distance. When you let go of the mouse button, REPTILES will
redraw the tiling with newly shaped tiles (unless reshaping violates certain symmetry
conditions, in which case nothing will happen).

After experimenting for a while you will probably notice that REPTILES doesn’t
give you very much control over the shape of edges, as each edge only gives you one
point to drag. We will see how to get past this limitation further below. (A future
version of REPTILES will have much better reshaping capabilities.)
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4.6. Changing the Appearance of Vertices, Edges and Tiles. The Edit menu
contains three sub-menus Vertices, Edges and Tiles, for moditying the appearance of
the constituents of a tiling.

To change the style, fill or color of an object such as a vertex, an edge or a tile of
a tiling, you must first select it. This is done either by clicking on it, or by dragging
a box around it. Note: In a periodic tiling there are many vertices, edges and tiles
that are equivalent to each other. For each such equivalence class of objects, only
one object is selectable! To find out which ones can be selected, use Select All in the
Edit menu. Another way to find the selectable objects is to choose Show Fundamental
Region in the Layout menu. This highlights a region containing all selectable objects.
To extend a selection, press the shift-key when selecting.

Select a tile. Next, open the Edit menu and go down to the Tiles sub-menu, which
should now be enabled. You have a choice between selecting a fill pattern and selecting
a color. Once you have made a selection, REPTILES will redraw the tiling. The vertices
and edges of a tiling can be modified in a similar way.

The best way to color tiles is to select the Random Color Tiles item in the Edit menu

We now want to change the width of some of the edges. First, select a number of
different edges by shift-clicking on their centers. If you can’t find anything selectable,
use Select All to find all selectable items. Now, enter the Edit menu and go down to
the Edges sub-menu. Then slide over to the Style menu and choose a width. Once you
have accomplished this task, try applying the Edges submenus’ Straighten item to a
bent edge ...

You can change the size of the tiles by selecting Bigger Tiles or Smaller Tiles in the
Layout menu.

4.7. Topological Transformations. The third type of modifications applicable to
tilings are topological transformations, found in the Topology menu. Each produces a
completely new tiling, which appears as a new document in a new window. Be aware
that the program often draws the new tilings quite different than you might expect
and sometimes it will take you quite a while to see that the new tiling is indeed
correct.

The most simple transformation is dualization, which you can perform by selecting
Dualize in the Topology menu. This will yield a new tiling which is dual to the original,
i.e. whose tiles correspond to the vertices, and whose vertices correspond to the tiles,
of the original tiling.

Next, let us consider vertex-truncation. This operation cuts off a vertex, i.e. re-
places a vertex by a new tile. You need to have precisely one vertex selected. You
can do this by first using Select All and then clicking on the vertex that you would
like to truncate. If exactly one vertex is selected, then the Truncate Vertex item in
the Topology menu will be enabled and you are set to go!

Now we will try edge-contraction, which removes an edge and pulls its two end
vertices together. You need to select precisely one edge. Moreover, the selected edge
must have the property that at least one of its end vertices is not incident to any
edge equivalent to the selected edge. In this situation the Contract Edge item will be
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enabled and you should go ahead and choose it.

The two Topology menu items Split Fundamental Tile and Glue Fundamental Tiles operate in a
similar way, but the selections needed to enable them are more complicated. To apply the first oper-
ation you need to select precisely two objects, vertices or edge- centers, that both lie in the boundary
of the same tile. Furthermore, the tile must be fundamental, i.e. asymmetric. Split Fundamental Tile
will join the two selected objects by a new edge, thus splitting the tile containing both. To enable
the second operation you need to select precisely one vertex or one edge-center. All tiles containing
the selected object must be fundamental and also equivalent via symmetries that keep the object
fixed. Glue Fundamental Tiles will then glue all directly surrounding tiles together.

These two operations are mathematically interesting, as it has been proven that starting with
the 46 so-called fundamental tilings (in Database Fundamental), the two operations can be used to
systematically generate all possible periodic tilings of the plane.

As mentioned above, each edge gives you only one point by which you can reshape
it. If you want more such points in an edge, then these can be obtained by selecting
the edge and then choosing Insert Di-Vertex in the Topology menu. This will insert an
artificial 2-valent vertex into the edge and then you will have 3 points to drag. Note
that you should do all such insertions before you start reshaping your tiles because
topological transformations loose all previous reshaping and also appearance changes!

4.8. Symmetry-Breaking and -Making. The Symmetry menu contains a number
of items for breaking and making symmetries. If your tiling contains reflectional
symmetries, then by selecting the Break Reflections item you will obtain a new tiling,
topologically the same as the original, but without reflectional symmetries. Similarly,
the Break Symmetries ... item can be used to remove other symmetries, such as
rotations etc. Oppositely, if you have an asymmetric tiling, then the Higher Symmetry
item will be enabled. After selecting this you will obtain all possible tilings that
are topologically the same as the original one, but which have a larger group of
symmetries.

4.9. Searching in Databases. Finally, let use return to the Heaven and Hell doc-
ument. It might be a good idea to first do some cleaning-up by selecting the Close
All Tilings item in the Windows menu. Click on the Heaven and Hell window to ac-
tivate it. REPTILES offers you a flexible search routine for finding tilings with given
properties within a Database. Select Find ... in the Database menu. Assume that
we need to find a tiling that has at least 4 different types of tiles and all its vertices
should have degree 6. Enter the following expression:

atleast 4 tiles and all vertices degree equal 6

Press Find First ... and then watch the scroll bar move ... To learn more about
possible search terms, press the Help button in the Find ... Dialog.

4.10. Further Features.

4.10.1. Undo, Copy and Paste. Of course you can Undo any changes of shape and
appearance of the tiling you are working on. Furthermore, you can Copy a tiling and
then Paste it into a document of some other application.
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4.10.2. Weavings. Some tilings look very nice drawn as weavings, i.e. drawn with
wide edges that alternately go over and under. If you select Draw As Weaving in the
Layout menu then REPTILES will try to draw the tiling as a weaving. Use the Weaving
Edge Width) item to determine the exact width of the edges used in the weaving. This
feature is rather experimental and not always successful ...

4.10.3. More on Searching in Databases. To understand the details of searching
through a tilings Database you really need to know quite a bit about the mathe-
matics of tilings. Here are some basic concepts. For further information, see [GS87].
A tiling always consists of tiles (obvious), edges (the common boundary of any two
tiles that meet), and vertices (any point at which more than two tiles meet, or an
artificial di-vertex, if inserted). The degree of a tile is the number of edges that the
tile has. The degree of a vertex, is the number of edges that meet at the vertex. A
tile, edge, or vertex, can have rotational or reflectional symmetries. Combining all
symmetries of an object gives its stabilizer group. If an object has rotational symme-
tries only, then it is said to have stabilizer group cl, c2, c3, ¢4, or c6, it it has either
no, or 2-, 3-, 4- or, 6-fold rotational symmetry, respectively. But, if the object also
has reflectional symmetries, then it is said to have stabilizer group d1, d2, d3, d4,
or d6, respectively. (Other rotational orders are not possible.) To search for a tiling
with specific properties, select Find ... and then enter a search term, e.g.:

all tiles degree atleast 5 and no vertex stabilizer cl

This will make REPTILES search for a tiling with the property that all its tiles
have at least 5 vertices and none of the vertices have stabilizer group cl. Press Help
for a table of possible search terms.

Entering number equal 23 will make REPTILES search for the 23rd tiling in the
Database. Entering maximal will search for a tiling whose symmetry group is as
large as possible for the given tiling. A tiling is orientable, if all its symmetries
are either translations or rotations, but not reflections or glide-reflections. A tiling is
colorable, if no two equivalent tiles of the tiling share a common edge.

If you specity group name, then REPTILES will search for a tiling whose symmetry
group has the given name. There exist precisely 17 different possible combinations of
symmetries for a periodic 2-dimensional tiling of the plane. These different combina-
tions, called the 17 crystallographic groups, have the following names:

pl, p2, p3, p4, p6,

cm, cmm, pg, pgg, pm, pmm, pmg,

p3ml, p3im, p4g, p4m and pém.
You can also use Conway’s orbifold notation. Search terms can be logically combined
using and, or, not and ()’s. To determine whether a given Tiling is contained in
one of your Databases, use the Find Tiling In Database ... item. You can extract
tilings from a Database to form a new Database by first setting a search term and
then pressing Extract ... in the Find ... dialog.

4.10.4. Editing Delaney Symbols. You can view and edit the Delaney symbol of the
tiling shown in the front Tiling window, after selecting the Mathematical Symbol ...
item in the Windows menu. Selecting this item will bring up a Dialog, displaying the
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current symbol. You can make changes to the Delaney symbol and then press the
Check button. REPTILES will then check your new symbol and tell you whether it is
o.k. or whether there is a problem. Once you have entered a valid symbol, you can
open the corresponding Tiling by pressing the Open button.

4.11. Printing. If you select the Print ... item in the File menu while a Tiling win-
dow is active, REPTILES will print the current tiling to cover the whole page. (Press
the shift-key simultaneously to print on an area the same size as the current window.)
If you select Print while a Database is the active window, however, REPTILES will
print about 20 tilings per page, starting from the top of the Database. This will give
you a catalogue of the tilings contained in the Database. If you are only interested
in certain tilings in the Database, then set the page numbers in the Print ... Dialog
accordingly ...

4.12. Description of Menu Items. Here we systematically describe all menu
items. Note that the enabled menu items apply to which ever window is active.
Note that some of the following menu items behave slightly differently if you press
the Shift Key as you enter the menu, as described in the following.

4.12.1. File Menu. As you would expect, this menu contains all the menu items
dealing with opening, closing, saving and printing documents. There are three open
commands: Use Open Tiling ... to open a tiling, Open Database ... to open a
Database, or use Open ... to open either type of document. (Shift-key: enable the
program to open plain text files containing Delaney symbols.) Use the Close item or click on
the close box in a window, to close a document. If the document is new or modified,
REPTILES will ask you whether the changes should be saved. (Shift-key: Close without
saving). The menu items Save Vertices ... and Save Trans Region ... should be
ignored.

Use PageSetUp and Print ... to print a document. A Tiling document is printed to
cover the whole page (Shift-key: Print same size as window ), whereas a Database document
is printed as 20 pictures per page. You can cancel printing by pressing Command-
period. If you want to finish using REPTILES, select the Quit command. (Shift-key:
Quit without saving).

4.12.2. Fdit Menu. As usual, the Undo command allows you to undo the last modifi-
cation to a document. The Copy item allows you to copy and paste the current tiling
into some other application, e.g. a drawing program. The Paste and Clear items have
no effect at present. The Select All item selects all vertices, edges and tiles of a tiling
in a Tiling document. This is a quick way to find the selection handles.

Use the Random Color Tiles item to choose random colors for all tiles. You will be
surprised how well the chosen colors match each other. Selecting Redraw will simply
make REPTILES redraw the active window.

The three submenus Vertices, Edges and Tiles can be used to change the appearance
of selected objects.

Vertices: If you have selected one or more vertices, then this submenu will
be enabled and you have the following choices: Selecting Style) will lead you
to a list of different vertex sizes, of which you can choose one (Shift-key: Much
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larger sizes). Selecting Fill) will lead you to a choice of fill patterns. Finally,
selecting Color ... will give you a choice of color.

Edges: If you have selected one or more edges, then this submenu will be
enabled and you have the following choices: Selecting Style) will lead you to
a list of different edge widths, of which you can choose one (Shift-key: Much
larger widths). Selecting Fill) will lead you to a choice of fill patterns. Selecting
Color ... will give you a choice of color. Moreover, you can use the Straighten
item to pull bent edges straight. (To quickly change the width of selected edges, press
a number key.)

Tiles: As above, you can choose the fill style and color of tiles in this submenu.

4.12.3. Layout Menu. The first three items Smaller Tiles, Larger Tiles and Default Tiles
change the size of the tiles. The Show Fundamental Region, Show Symmetries and Show
Subdivision items make REPTILES show a fundamental region for the given tiling,
show all rotational symmetry centers, or show the so-called barycentric subdivision
of the tiling, respectively. These items can only be applied to a Tiling document.

The Draw As Weaving item makes REPTILES attempt to draw a tiling using strands
that alternately go over and under each other. This only works well for tilings whose
vertices all have even degree. Use the Weaving Edge Width) sub menu to chose the
strand width. (Shift-key: Much larger widths)

Delaney symbols, the underlying data structure for this program, encode tilings
together with their symmetries. It can easily happen that the picture drawn has more
symmetries than encoded by the Delaney symbol. The Exact Symmetry item forces
the program to draw the tiling with the correct symmetry. In most cases this is done
by bending an edge.

The last two items in this menu are only enabled when a spherical tiling is displayed
in a Database document. If the Draw Smoother Sphere item is checked, the program
draws a smoother approximation of the spherical tiling. Selecting Draw Back Edges
makes the program draw back edges ...

4.12.4. Database Menu. Most commands in this menu apply to Database documents
only. The first three items can be used to search for tilings with specific properties

in a Database. The Find ... item opens a dialog window in to which you can enter
a search term. There are a number of buttons that you can then press: Find First,
Find Next, Don't Find, Extract ... , Help and Cancel. Only the Extract ... needs

explaining. Use this to create a new Database document containing all those tilings
in the original one that match the given search term. For a table of possible search
terms, press the Help button.

The Extract ... menu item has the same function as the button described above.
Use the Join ... item to concatenate Database documents. If you check the Discard
equivalent tilings box in the Join dialog, copies of equivalent tilings will be discarded.

If a Tiling document is active and one or more Database documents are open, then
you can use the Find Tiling in Database ... command to determine whether the active
tiling is contained in one of the open Databases.

Selecting the Display Mode item will make REPTILES cycle through the active
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Database document, displaying each tiling briefly, before going on to the next. (Shift-
key: Turn display-mode on or off for all open Database documents)

Depending on whether a Tiling or Database document is active, the bottom item
in the Database menu is labeled Open As New Database or Open As New Tiling. The
former command copies the active Tiling to a new Database document, whereas the
latter does the opposite. Pressing the New button at the bottom left corner of a
Database window is equivalent to selecting the Open As New Tiling item.

The two commands Multi-Split ... and Multi-Glue ... can be used to systematically
generate new tilings from old.

4.12.5. Topology Menu. These commands apply only to a Tiling document. Except
for the first command, all items in this menu require at an appropriate selection
of vertices and edges has been made. Only then will the menu items be enabled.
Moreover, the operations are implemented in terms of Delaney symbols. So, when
the new tiling appears in a new window, it will not always be easy to see how the
old and new tilings are related to each other. This is because Delaney symbols only
contain topological and symmetry-related information, but no geometric details.

This menu contains a number of operations that change the topology of a given
tiling, without changing the symmetries. To compute the combinatorial dual of a
given tiling, select the Dualize item.

If you have selected precisely one vertex, then the Truncate Vertex item will be
enabled. If you select this item, the program will replace the selected vertex by a new
tile and draw the new tiling in a new Tiling document.

If you have selected precisely one edge, and if that edge can be contracted, then
the Contract Edge item will be enabled and selecting it will make REPTILES compute
the tiling one obtains by contracting that edge.

The two items Insert Di-Vertex and Delete Di-Vertex can be used to add or delete
vertices of degree two. The former command is useful if you want to create a tiling
will edges that have a large number of corners. For example, if you want to tile the
plane by REPTILES or swans. The additional vertices give you more points to deform
with.

The Split Fundamental Tiles and Glue Fundamental Tiles are interactive versions of the commands
Multi-Split and Multi-Glue contained in the Database menu. The first command is applicable, if you
have selected precisely two objects, i.e. vertices or edge-centers, that lie in a common fundamental,
i.e. asymmetrical, tile. This command splits that tile into two new tiles, from the one selected object
to the other. Because this splitting process really depends on more than just a choice of two objects,
the split computed is not always what one might hope for. To get a specific split, one can always

turn the given Tiling document into a Database document and then apply Multi-Split. This will
produce all possible splits.

The Glue Fundamental Tiles item is enabled, if you have selected precisely one vertex or edge-
center that is completely surrounded by equivalent fundamental tiles and if the stabilizer of the
point object operates transitively on the surrounding tiles. In this case, the command forms the

union of the surrounding asymmetric tiles and produces a new tile with higher symmetry.

4.12.6. Symmetry Menu. If you have a Tiling with reflectional symmetries, then the
Break Reflections will create a new Tiling with the same topology, but without the
reflectional symmetries.
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To break symmetries in a more general way, select the Break Symmetries ... item.
This leads to a dialog window which allows you to choose the degree of symmetry
breaking. Please note that the algorithm used is really bad and hence you can only
hope to do symmetry breaking by degree 2 or 3 for small symbols. One day we hope
to rewrite the algorithm ...

Finally, the opposite of symmetry-breaking is symmetry-making. If you select the
Higher Symmetry item then REPTILES will compute a Database consisting of all
tilings with the same topology but more symmetry than the given one.

4.12.7. Windows Menu. Use the Mathematical Symbol ... item in this menu to
inspect the Delaney symbol associated with the active tiling. This will open a dialog
window displaying the Delaney symbol in an editable form. A Delaney symbol is a
finite, connected graph with three types of edges called 0-, 1- and 2-edges, one edge
of each color adjacent to every vertex, and two functions mg; and m, defined on
it’s 0,1- and 1,2-sub graphs. The former number mg; reflects the number of edges
of a tile, whereas the latter number m, indicates the vertex degrees. The window
displays the size of the graph, the different types of edges written as permutations
and the two functions. You can edit the values and then press the Check button to
test whether the entered symbol is valid. If it is, you can open a new document based
on the modified Delaney symbol by pressing the Open button.

Use Close All Databases or Close All Tilings items to close all documents of the given
type (Shift-key: Close without saving). The bottom of this menu contains a dynamic list
of all open windows which can be used to switch from one window to the other.
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